
From the Office of Clinical Informatics 

Northern Light Health 
Code Upgrade 

Clinical EHR Flash Flyer 
 

 July 19, 2023 

Table of Contents 

Visual updates ................................................................................................................................... 2 

Visual display .......................................................................................................................................................... 2 

Chronological View ................................................................................................................................................ 2 

Emergency Department ................................................................................................................... 2 

Enhanced Tracking Board ..................................................................................................................................... 2 

Acute Case Management ................................................................................................................. 3 

Printing Reports ...................................................................................................................................................... 3 

Alerts ................................................................................................................................................... 3 

PowerForms ............................................................................................................................................................ 3 

MPage Updates ................................................................................................................................. 4 

Histories Component ............................................................................................................................................. 4 

Home Medication Component ............................................................................................................................. 4 

Clinical Charge Entry Component ....................................................................................................................... 4 

Capacity Management (New 7/12/23) ........................................................................................... 5 

Staffed Beds ............................................................................................................................................................ 5 

Imaging Department ........................................................................................................................ 5 

Rad Online Worklist ............................................................................................................................................... 5 

Known Issues ..................................................................................................................................... 6 

HealtheCare ............................................................................................................................................................. 6 

Zooming in – Immunization Component ........................................................................................................... 6 



Return to Table of Contents 

From the Office of Clinical Informatics 
Northern Light Health 

Code Upgrade 
Page 2 of 7 

 

Special Characters – CM Note ............................................................................................................................... 6 

Printing a Patient List ............................................................................................................................................ 6 

Navihealth/CarePort Errors ................................................................................................................................... 7 

Cardiovascular March Out .................................................................................................................................... 7 

Pharmacy Medication Manager ........................................................................................................................... 7 

Power Trials ............................................................................................................................................................. 7 

 
Click here for the latest Registration, Scheduling, Referral Management, Experian, Charge Management, 
and other Revenue Cycle updates! 

Visual updates 

Visual display  
 Windows will now display without borders within Cerner.  

 The Idle timer will display in an aqua color.  

Chronological View 
 Vital signs will display the most recent results 

documented.  

Emergency Department 

Enhanced Tracking Board 
 When a patient’s Administrative Sex, Birth Sex, or Gender differ, an indicator will display on the 

FirstNet Enhanced Tracking Board, as it does on the banner bar when in the patient’s record.  

https://intranet.emhs.org/EMHS/Portals/Revenue-Cycle/Sub-Menu/Revenue-Cycle-Learning-Development-(1).aspx
https://intranet.emhs.org/EMHS/Portals/Revenue-Cycle/Sub-Menu/Revenue-Cycle-Learning-Development-(1).aspx
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 This information will be found within the Birth Sex/Gender Identity column. 

Acute Case Management 

Printing Reports 
 The Type is displayed in the FIN/Visit Reason/Attending/PCP column instead of the LOS/ELOS 

column. 

 The medical service is displayed on the Acute Case Management responsive worklist.  

 Important notes on the Print Report are marked with an asterisk. 

Alerts 

PowerForms 
 When you sign a PowerForm, the system now displays a Sign Charting confirmation dialog box when 

you attempt to sign a PowerForm.  
 Select Do not show sign confirmation again to not display 

this dialog box moving forward.  
 To display the Sign Charting 

confirmation window again, 
check the box, Show Sign 
Confirmation, in the top right of 
any PowerForm.  

 Recommendation component 
 An error will display when trying to view a completed document from the HealtheLife Registries 

Portal; however, this will not impact the ability to chart, reconcile, and pulled to the correct MPages.  
 In the Recommendations component, when you try to open a PowerForm from the Actions menu, 

an error is displayed.  
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MPage Updates 

Histories Component 
 The Laterality of a procedure can now be added or modified.   

Home Medication Component 
 The Legal Expiration date for a prescription displays below Refills in the 

Supply Remaining column.  

Clinical Charge Entry Component 
 If the wrong note was associated to a charge, the correct note can 

be associated within the Clinical Charge Entry component with 
the applicable charge.  

STEP 1: From within the submitted charge section, single-click the charge 
in question and select Modify.  

STEP 2: Click Change Selected Note  next to the note to be changed. 
STEP 3: Select the appropriate note and click OK. 
STEP 4: Click Submit to save the modifications.  

 Providers are able to delete and modify submitted charges from the Clinical Charge Entry 
component. 

STEP 1: From the submitted charge section, single-click the charge. 
STEP 2: Click Delete to remove the charge. 
STEP 3: Click Delete to confirm. 

STEP 4: Refresh the component.  
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STEP 5: The note will be available to add the charge. 

Capacity Management (New 7/12/23) 

Staffed Beds 
 The staffed beds button will be used when decreased staffing occurs to automatically block beds to 

correlate with the current staffing numbers.  

Click (here) for more information on the staffed beds workflow. 

Imaging Department 

Rad Online Worklist 
 When you open row, staff will see a filter that limits the number of cases that can be displayed.  

 This filter can be set from 100-1000, as it is a user setting and not a global setting.  

STEP 1: From View menu, select Options > Interval Options.  
STEP 2: In the Number of Cases to be Displayed box, enter a value between 100 and 1000. 
STEP 3: Select the up and down arrows to change the value of the number of cases to be displayed. 
STEP 4: Select OK. Once the list of exams loads, the total number of cases is displayed at the bottom of the 

application as follows:  
 Total Cases: N+ (the number of cases the 

user has set in the Options window): We 
found too many matches to show them all. 
Refine your criteria).  
 For example, if you enter 100, and 

more than 100 cases are present, the 
following message is displayed: Total 
Cases: 100+ (We found too many 
matches to show them all. Refine 
your criteria). If fewer than 100 cases 
are present, only the number of cases is displayed. The setting can be updated by going to 
View > Options > Interval Options.  

https://ci.northernlighthealth.org/Flyers/Non-Providers/Hospital-Nurse/Cap-Mgmt/CapMan-Staffed-Beds.aspx
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Known Issues 

HealtheCare 
 The Potential Cases List (PCL) displays only the initial list of up to 20 candidates when you filter, sort, 

or advance to additional pages of the candidate list.  

Zooming in – Immunization Component 
 The Workflow Immunizations component is not displayed correctly if you zoom in or open the 

component on various screen sizes. 

Special Characters – CM Note 
 A known issue is currently occurring that is adding special characters to the Discharge planning 

notes.  

Printing a Patient List 
 When printing a patient list, additional steps will be needed to 

locate the applicable printer the first time to make this the 
default printer.   

STEP 1:  Select the Other Output Devices tab within the Output 
Destination window.  

STEP 2: Locate the location in which you are located and single 
select.   

STEP 3: Right-click the printer and select Select as Default.  

 Right-click the printer to Add to Favorites and to be 
available within the Favorites tab.  
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Navihealth/CarePort Errors 
 Update 7/12/23 – the Sporadic transmission issue has been resolved. With the package update to fix 

this, another potential issue has been revealed. The button that said Upload to naviHealth has been 
changed to Upload to Undefined. The button functions in the same way, it just has a name change.  

 Sporadic issues are occurring, impacting successful transmission of packets. IS is working on a 
resolution.  If a packet is not sent successfully, downtime process should be followed.  

Cardiovascular March Out 
 The March Out menu is still displaying on the screen when the viewer is minimized. Open the ECG 

study via the Cardiology Worklist to prevent this from occurring.  

Pharmacy Medication Manager 

 When a PRN order is placed from PowerChart or MedManager, the PRN reason is not displayed.  
 Perform a Verify, Modify, Inquire, or History action to the order to view the PRN reason.  

Power Trials 
 Within the Clinical Trial Non-Therapeutic Protocol, View/Edit Enrollment is dithered when trying to 

right-click a patient name.  

 When selecting Save Document then import, the document will not display to enable to select open.  

 When trying to click Document Management, the Document Manager icon is dithered.  

 When trying to select the Enrolled Patients tab and select the Add Enrollment button, Add 
Enrollment will not allow a user to save.  

 When trying to right-click the initial protocol and select view document, view document is dithered.  

For questions regarding process and/or policies, please contact your unit’s Clinical Educator or Clinical 
Informaticist.  For any other questions please contact the Customer Support Center at:  

207-973-7728 or 1-888-827-7728. 
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